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Thank you… 
For purchasing another fine product from 

Amano Cincinnati, Inc. 

This Payroll Guide covers the following Amano Time & Attendance software;  

 Time Guardian v5.0 and higher 
 Time Guardian Plus v2.0 and higher 
 Time Guardian Pro v4.0 and higher 

 

Proprietary Notice 
 

This document contains proprietary information and such information may not be reproduced in 
whole or in part without written permission from: 
 

Amano Cincinnati, Inc. 

140 Harrison Avenue 

Roseland, New Jersey, 07068-1239 
 

Amano Cincinnati Inc. reserves the right to make equipment changes and improvements that 
may not be reflected in this document. Portions of this document may have been updated to 
include the latest software, hardware, or firmware version, if applicable. 

We recommend that this document be read in its entirety before any attempt is made to operate 
the equipment. 

 

For more information about Amano’s complete line of products, visit our web site at: 
 

www.amano.com/time  
 

Licenses and Trademarks 

Amano and Time Guardian are registered trademarks of Amano Cincinnati, Inc. 

Adobe Acrobat and Acrobat Reader are registered trademarks of Adobe Systems Incorporated. 

InstallAnywhere and InstallShield are registered trademarks of Acresso Software. 

Microsoft® SQL Server®, Windows Vista®, Windows NT, Windows XP, Windows 2000, Windows 7 are 
trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries. 

Peachtree is a registered trademark of Sage. 

Paychex Paylink and Paychex Preview are registered trademarks of Paychex, Inc. 

QuickBooks® Pro® are trademarks and service marks of Intuit Inc., registered in the United States and 
other countries. 

Other product names used herein are for identification purposes only and might be trademarks of their 
respective companies. We disclaim any and all rights in those marks. 
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Chapter 1: Introduction 
 

Welcome to Amano Time & Attendance Software Suite 

Welcome to Time Guardian, Time Guardian Plus, and Time Guardian Pro the all in one, easy-
to-use Time and Attendance software. Amano’s Time and Attendance software allows you to 
track and manage your employees’ time and attendance directly from your PC, which makes 
the collecting, reporting and the transferring of employees’ hours to payroll companies easier 
and quicker than ever before. 

Should you have any comments on Time Guardian, Time Guardian Plus, Time Guardian Pro 
and the materials provided we ask that you e-mail them to TimeGuardian@amano.com. All 
feedback is welcome and greatly appreciated, and will help us provide a better product to you, 
our customer. 

We thank you for selecting Time Guardian, Time Guardian Plus, or Time Guardian Pro and 
welcome you to the Amano Cincinnati family of Time Solution and Access Control products. The 
following table lists the standard and optional features for all Amano Time & Attendance 
software. 
 
Feature/Module Time Guardian Time Guardian Plus Time Guardian Pro 

Time & Attendance 
software with 100 
employee capacity with 
13 standard Payroll 
Interfaces 

Standard 
Version 5.0 

Standard 
Version 2.0 

Standard 
Version 4.0 

Employee Capacity 
Upgrade 

Optional 25, 50, 100, 
250, 500, 1000, and 

unlimited 

Optional 25, 50, 100, 250, 
500, 1000, and unlimited 

Optional 25, 50, 100, 250, 
500, 1000, and unlimited 

Number of concurrent 
users 

1 5 1 

Concurrent User 
Upgrade 

Optional 1, 5, 10, 25, 
and unlimited 

Optional 1, 5, 10, 25, and 
unlimited 

Optional 1, 5, 10, 25, and 
unlimited 

Advanced Overtime Optional Optional Standard 

Advanced Scheduling Optional Optional Standard 

Advanced Meal Optional Optional Standard 

Advanced Rounding Optional Optional Standard 

Advanced Labor/Rate Optional Optional Standard 

Advanced Pay Class Optional Optional Standard 

Access Control Optional Optional Standard 

Web Interface Optional Optional Standard 

Zone Differential Optional Optional Standard 

Event Notification Optional Optional Standard 

Benefit Time Optional Optional Standard 

Payroll Interface 
(additional interfaces) 

Optional Optional Optional 
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Features for Base Time Guardian Software (Expandable) 

 Multi-user with standard support of 1 concurrent user for Time Guardian and 5 concurrent 
users for Time Guardian Plus and Time Guardian Pro [Optional support for additional 
concurrent users is available for all packages with the User Module activation – see 
previous table]. 

 Standard one hundred (100) Employee Capacity (not including inactive employees), with 
available upgrade from 25 additional employee capacity to unlimited maximum (see 
previous table). 

 Thirteen (13) Built-In Payroll Interfaces [Optional Payroll Module activation can supply 
additional Payroll Interfaces from 1 to 45 additional – see Output Group/Payroll Module 
section for additional information]. 

 Fixed Template Schedule (one schedule per day). [Optional Advanced Schedule Module 
activation unlimited number of schedules with auto schedules, Template Schedules with 
Auto Schedule, Individual/Advanced Schedules, Schedule Rotation, and Employee 
Schedule Override]. 

 One Labor level (fixed to department). [Optional Advanced Labor/Rate Module activation 
can supply additional 5 labor levels – see Advanced Labor/Rate Module section for 
additional information] 

 Unlimited Number of Departments. 

 Time Rounding Capability Based on Company-Defined Pay Class (Customizable 
Rounding). [Optional Advanced Rounding Module activation can supply additional 
advanced Pay Class and/or Daily Rules rounding schemes – see Advanced Rounding 
Module section for additional information] 

 Nine (9) Predefined Pay Codes for Hours Allocation with Pay Code Multipliers. 

 Rates for Wages calculation. 

 Two (2) Pay Codes for Tips and Bonuses. [Optional Advanced Overtime Module 
activation adds TT (triple time pay code). 

 Nine (9) Predefined Exception Flags for Employee Punch Tracking. 

 Nine (9) On Demand Reports. [Optional Advanced Pay Class Module activation adds 2 
reports (Unauthorized Hours report and Time Card Report).Optional Advanced Schedule 
Module activation adds 2 reports (Schedule Posting and Schedule vs. Actual Reports). 
Optional Benefit Time Module activation adds 2 reports (DeAccrual Balance and 
DeAccrual History Reports)]. Optional Advanced Labor Rate Module activation adds up to 
6 labor levels to reports and show billable rates on reports). 

 Optional Access Control integration with Amano Nexus 220 and AmanoNet systems. See 
Access Control Module section for additional information. Employee and department 
synchronization with auto sync on login. 

 Automatic Polling of Data Collection Terminal. 

 Bell Schedule Capabilities. 

 Firebird or MS SQL Database. 

 Several Built-In Utilities for Maintenance of the System. 
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Chapter 2: Installation for QuickBooks 
 

There are five documents available to assist you in the setup and use of your Amano Time & 
Attendance software: This Payroll Guide, the Installation & User Guide, the FPT-40 
Terminal/Time Guardian Quick-Start Guide, the MTX-15 Terminal/Time Guardian Quick-Start 
Guide, the MTX-15 Installation & Operation Guide, and the FPT-40 Installation & Operation 
Guide. All these documents can be accessed and printed from the Time & Attendance  
software CD. An overview of the software installation steps for QuickBooks is as follows: 

 

Step 1. Insert the Time & Attendance CD  
into your CD-ROM drive, and the  
InstallShield Wizard will  
automatically launch. If the installation 
stalls, browse on CD to  
\Disk1\InstData\Windows\VM\install.exe 
Full integration with QuickBooks Pro 
can require QuickBooks to be installed  
on the host PC and open during installation. 

 

Step 2. After the initial software installation, the 
Amano Software Activation screen will 
appear. Enter the 9-digit serial number 
and click the Activate button. Upon 
successful activation perform on-line 
registration. Next the user will be prompted 
to proceed through the 9-Step  
Setup Wizard. 

 

 

 

Step 3. Login to the Time & 
Attendance software, and 
perform daily activities 
such as Timecard 
Administration and 
Payroll, etc. The software 
by default will support 100 
employees. If you have 
more than 100 
employees, contact 
Amano Support to obtain 
an incremental upgrade 
from 125 to an unlimited 
number of employees. 
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QuickBooks Payroll Interface Installation 

The following discussion utilizes Time Guardian for screen illustrations. The installation of the 
Amano Time & Attendance software is as follows: 
 

1. Insert the Amano CD into your CD-ROM drive. The software program should automatically 
launch the InstallAnywhere® Wizard (see figure). 

2. Follow the on-screen prompts as discussed in the Installation and User Guide untill the 
QuickBooks utility executes and the QuickBooks InstallShield Wizard for QBFC appears. 

 

 
 

3. Click on the Next button to start the InstallShield for QuickBooks FC or Cancel if you are not 
using QuickBooks payroll software. 

 

 
 

4. Click on the Finish button to complete installing the QuickBooks InstallShield Wizard for 
QBFC. 

 

 
 

5. Next, click on the Install button to begin installing the QuickBooks Remote Data Sharing 
Client or Cancel if you are not using QuickBooks payroll software. 
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6. Click on the Next button to start the InstallShield Wizard for QuickBooks Remote Data 
Sharing Client and execute the Data Share Client utility, or Cancel if you are not using 
QuickBooks payroll software. 
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Chapter 3: Setup Wizard 
 

It is recommended that you utilize the Quick-Start Guide and/or reference the Installation & 
Operation Guide as you proceed through the Setup Wizard. 

The Setup Wizard will help guide the user through a seamless step-by-step initial configuration 
of the Time & Attendance software. As data is entered in each step the Setup Wizard can be 
sequentially advanced to complete the next step. Once initial Setup Wizard is complete and the 
Time & Attendance software is logged into, the Setup Wizard can be accessed from the Edit 
menu at any time to modify the software configuration, i.e., add terminals and employees. 

 

 

Using the Setup Wizard 

From the Setup Wizard “Steps Summary” screen click on the Next  button to continue with 
Step1. The Wizard Help will guide you through the Wizard Steps. The Setup Wizard has 9 
Steps (see figure), however, as a minimum only Steps 4, 7 and 9 are required with at least; 1 
Pay Class, 1 employee, and 1 user login defined. These steps will have Red X’s alongside 
them until they are completed, at which point Green checkmarks will appear. 
 

 
 

Amano recommends that you have the appropriate information before you begin the Setup 
Wizard. Should you need to exit the Setup Wizard before completion, your settings will be 
saved. 

Once the Setup Wizard is finished, the Wizard Complete  button will become active. At this 
point, all settings will be applied, including the time synchronization between the Time & 
Attendance software PC and the connected terminals. Integration with Nexus220, and 
AmanoNet 7.6 for Access control systems may require the activation of Access Control module 
which is standard in Time Guardian Pro. 

If the Wizard Complete button is not active, you must review your setup, verifying that all 
mandatory fields (in red) have been completed. When all required fields are complete, the 
Wizard Complete button will then be displayed. 
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Should you have any questions or require additional information, please email 
TGSupport@Amano.com. 

The following information will sequentially guide the user through the Setup Wizard data entry. 
See the remaining sections of this Time & Attendance software Installation & User Guide for 
more additional functional descriptions especially sections describing the functionality of the 
Advanced Modules. 

Note: Time Guardian screens are used for illustrative purposes in the Setup Wizard. Some 
advanced modules may have been activated to illustrate their setup features. 

 

 

Step 1: General Setup Wizard [Optional Wizard Setup Step] 

 

 
 

Please consult the User Guide for details about this Wizard Setup Step. 
 

Do you want to send employee hours to your payroll software? 

From Step 1: General Setup, select Yes if you want employees' hours to be transferred to your 
payroll software. You must then select the Payroll Software that you are using. The following 13 
payroll software options are available (see figure): 

 ADP for DOS 

 ADP PC Payroll for Windows® 

 CBS Payroll 

 Ceridian Power Pay 

 EasyPay 

 Excel 

 Gevity HR 

 PayDay 

 PayChex Paylink® 
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 PayChex Preview® 

 PayWeb 

 PeachTree® Win 

 QuickBooks Pro® 
 

 
 

Note: The Apply and Close button function is universal for all Setup Wizard steps. 

QuickBooks Pro Procedure 

1. Select Yes to send employee hours to payroll software and select QuickBooks from the 
dropdown menu. 

2. Select Yes if QuickBooks is installed on the same PC with the Time & Attendance software, 
or No to connect across network to QuickBooks. See Step 7: Employee Setup for 
integration/synchronization with QuickBooks. 

Note: 40 plus additional payroll interfaces are available with Payroll Interface module 
upgrade activation. See Payroll Interface Module for a list of Payroll Interfaces. 

After saving the information for Step 1: General Setup, click on the Next  button to advance 
to Step 7: Employee Setup. 

Note: You can close at any time to end the Setup Wizard, but you must complete the Setup 
Wizard before you can Log into the Amano Time & Attendance system. The Wizard will 
automatically open up to the Welcome screen until it is completed. 
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Step 7: Employee Setup Wizard [Required Wizard Setup Step] 

 

 

 

Do you want to import employee information from specific file? 

Answer Yes to this question if you want to use this built-in import feature. This feature allows 
you to import employee information from a text file directly into the Time Guardian database. To 
use this feature, you will need to know the name and location of the file to be imported. 

Click on the Employee Import button and the Import window (see figure) will appear on the 
General tab. 
 

 
 

Note:  Default import fields are provided to be used and defaults will be used if the imported file 
does not contain data for those fields. 

 

1. Create a new Employee Import file. You will be required to enter a Name. 

2. In the Name field, enter a name for the Import profile. 
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3. Enter a brief description of the Import profile in the Description field. 

4. Enter the name and path of the import file in the File Name field, or click on the browse 
button to the right of the field to browse for the file you wish to import. 

5. Select the Import Type from; Employee, Individual Schedule, or Advanced Schedule. Select 
whether or not you want to Override Existing employee data. 

6. Click on the Import File Format Settings tab. This tab helps to define the format of your 
import profile. If these parameters are not set to properly match the import file, the import 
process might fail. The file contents window on the Import Field Map Settings tab screen will 
help to indicate the file format. Pay attention when you select the following for an example: 

 

 
 

 Delimiter: Select a Delimiter from the dropdown list. The Delimiter is the character, 
which separates the data elements from one another. The choices are: Tab, Comma, 
Pipe, Semicolon, Backslash, Forward slash, or User Defined. If User Defined is 
selected, you must enter the character in the field provided. 

 Text Qualifier: Select a Text Qualifier from the dropdown list. The choices are: None, 
Single Quote, or Double Quote. The Text Qualifier is the character, which encapsulates 
a data element (i.e., “California”). 

 Date Format: Select the date format from the dropdown lists. The choices are: Month 
(1), Month (01), Month (Jan), Month (January), Year (90), Year (1990), Day (1), Day 
(01), and Day (Mon). 

 Hour Format: Select the hour format. The choices are; Hour (8:00), Hour (08:00), Hour 
(08.00), or Minutes (480). 

 Full Name Format: Select the Full Name Format from the dropdown list. The choices 
are; FirstName LastName; FirstName Middle LastName; FirstName,Middle,LastName; 
LastName FirstName; LastName,FirstName; and LastName,FirstName Middle 

Note: This field will be available for assignment in the Import Field Map Settings tab. 

7. Click on the Import Default Settings tab. This tab allows you set the defaults for data being 
imported. Select the following: 
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 Employee Number: Select how the Employee Number will be defined. The choices are: 
As it is, Same as Badge, or Manual Increment From. If Manual Increment From is 
selected, you must enter the starting number in the field provided. 

 Badge Number: Select how the Badge Number will be defined. The choices are: As it is, 
Same as Employee Number, or Manual Increment From. If Manual Increment From is 
selected, you must enter the starting number in the field provided. 

 Payroll Number: Select how the Payroll Number will be defined. The choices are: As it 
is, or Same as Employee Number. 

 Default Labor: Assign a default category for each Labor Level using the dropdown lists. 

 Default Assignment: Assign a default Pay Class, Time Zone, and Schedule, using the 
dropdown lists. Also, when Advanced Overtime Module is activated you can assign from 
a “Daily Rule” and when Zone Differential Module is active you can assign a “Zone”. 

Note: The defaults will be used if the import file does not contain data for these fields. 

8. Click on the Import Field Map Settings tab. This tab allows you to manually define the 
elements of the import file you are using. 
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Note:  The data elements in the selected list should match the data fields of the import file. The 
selected data elements should also be in the same order as they appear in the import 
file (use the Move UP & Down buttons if necessary). 

The contents of your import file will be displayed line by line in the File Contents window 
(see figure for example). This area allows you to assign fields to data elements in each line. 
You can select to import a single line, a selected group of lines or all lines. 

 

 
 

To set the row number of the import file that the import operation will begin at, enter a 
number in the Start Import At Row field. 

Each data element in the import file must be defined in the order that it appears. Data 
elements can be separated by commas, tabs, and semicolons. To assign a field, select a 
data element in the Available list and click on the Add button. To select all the fields, click 
on the Add All button. The field(s) will then be displayed in the Selected list. Add additional 
fields until all data elements have been properly defined. Use the Remove Fields button to 
un-assign fields. To skip a data element, click on the ][ button. A “][“ character will appear in 
the Selected list to indicate that a data element was skipped.  

To re-order fields in the Selected Window, use the Move Up and Move Down buttons. 

7. Click on the Run Import  button, to Import an employee file into the Time & Attendance 
software. 

8. Click on the Apply  button to save the Import information and return to the Step 7: 

Employee Setup. Click on the Close  button close the Import window without saving. 

 

Would you like to create employees at this time? 

Click Yes for this question and press the Employee button if you want to enter employees. The 
Employees module (see figure) of the Time & Attendance software allows you to have up to one 
hundred (100) active employees and assign them a schedule with Pay Class and wages. 

Note: Optional additional active employee amounts are available upon activation for 
incremental increase all the way up to an unlimited number of employees. 

Each employee record requires a unique Employee and Badge number, both of which are 
entered in the Employee module on the General tab (see figure). The standard Employees 
module for Time Guardian consists of seven (7) tabs: General, Personal, Contact, 
Assignments, Schedule, Labor Level, and Wages. Activation of the Access Control module 
can add Nexus 220 or AmanoNet [for access control] when selected in Wizard Setup Step1. 
Activation of the Benefit Time module will add the Certification and Benefit tabs. Activation of 
the Web Access module will add the Web Access tab. 

The Pay Type will only be active when Salary has been selected for the Type of Employee. The 
Time & Attendance software has two Employee Types: 

 Hourly employees – These employees are required to punch at the clock in order for hours 
to be calculated and awarded. 
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 Salary employees – These employees must have an assigned schedule and are paid 
automatically either By Hour or By Schedule. 

 

Note: Remember when creating a Salary Employee you must have a schedule before hours 
will be calculated. A salaried employee with Pay by Hour can punch for exception 
tracking, while a salaried employee with Pay by Schedule cannot punch. 

 

You can lookup employees from any of the Employee screens by clicking on the Filter 

Employee  icon on the top of each Employees screen to filter employees with using Pay 
Class, department, and/or employee criteria. The following is an example of the screen that will 
appear when you click on the Employee tab from the Employee Filter screen: 
 

 
 

By default, all employees are selected. You can filter out employees by selecting: 

 To add an employee to the list, highlight the desired employee in the Available list and 
click on the Add button. To add all employees to the list, click on the Add All button. 

 To remove an employee from the list, highlight the desired employee in the Selected list 
and click on the Remove button. To remove all selected employees, click on the 
Remove All button. 

 Select the desired sort criteria from the dropdown list. Both the Available and Selected 
lists of employees can be sorted by typing in the “Criteria” fields above each list. 

 Click on the Pay Class tab to utilize available Pay Classes as a filter for employee 
reports and follow the same preceding procedure. 

 Click on a Department tab to utilize available departments as a filter for employee 
reports and follow the same preceding procedure. 

 

From Setup Wizard in Step7: Employee Setup, check the box to Sync Employee(s) with 
QuickBooks and select the method of synchronization from the dropdown choices of; Import 
from QuickBooks, Export to QuickBooks, or Both ways [bi-directional]. 

The synchronization will be performed depending on what was selected for the method of 
synchronization in the Wizard Employee Setup for how to Sync Employee(s) with 
QuickBooks with the choices of; 

 Import from QuickBooks – QuickBooks acts as the master. Suggested for scenario 
where you already have the QuickBooks as the payroll software and the Time & 
Attendance software is being added. 
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 Export to QuickBooks - Suggested for scenario where you already have the Time & 
Attendance software and QuickBooks is being added as the payroll software. 

 Both ways – Employee information will bi-directional transfer, but QuickBooks remains 
as the master. If employee is changed in the Time & Attendance software, the employee 
change must be updated in QuickBooks to maintain good synchronization. 

When you have finished, click on the  button to save your settings. 

Note: This function can also be done with Global Apply command from the main employee list. 

Create a new Employee and you will be required to enter a Name, etc. Click on the necessary 
tabs to complete the entry of employee information. See the following paragraphs for 
description. Also, see the Employee Administration chapter. 

 

After completing the entry/selection of payroll information for Step 7: Employee Setup, click on 

the Next  button to continue to Step 9: Login Setup. 

 

 

Step 9: Login Setup Wizard [Required] 

 

Please consult the User Guide for details about this Wizard Setup Step. 
 

Please create your personal login 

The Login Setup allows you to create User profiles/accounts and assign access privileges to the 
accounts in Time Guardian. 

 When you add a profile, the option for the Administrator or Read Only access is provided. 
Once an Administrator has been given access, they will have the ability to add, modify and 
edit any data contained in the system. 

Note:  At least one administrator profile must be created in this step. Each profile consists of a 
Name, Password and Language selection. 

 Selecting Default User will cause this Login to be displayed each time the Time Guardian is 
opened. 

Press the Login button and the following Users screen will appear to enter general info for 
account settings. The User’s window consists of (5) tabs: General, Password, Pay Class, 
Department and Employee (see figure). 
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To create a User account: 

1. In the General tab, enter the name of the individual or account you are adding in the Name 
field. 

2. Select the type of group you want the user to belong to from the dropdown choices of; 

Administrator – will have full access to all functions (all modules). 

Payroll – No access to Setup Wizard from the Edit menu. Only access to Employee, 
Timecard, Communications, and Recalculate modules. Also access to Reports and Payroll 
modules. However, no access to Global assign and apply functions. 

Supervisor – No access to Setup Wizard from the Edit menu. Only access to Employees, 
Timecard, and Reports modules. However, no access to Global assign and apply functions. 

Note: Only Users created during the initial Setup Wizard will have default Report and 
Payroll (if created) profiles. 

3. In the Account Settings section, select the following: 

 Disabled: If checked, the user will be disabled. (Enabled is default) 

 Expires On: When checked, the password will expire on a given date. When the date 
arrives, a check will automatically be placed in the disabled option. 

 Read Rates: When checked, the user will have read-only access to the Rates’ modules. 

 Write Rates: When checked, the user will have write access to the Rates’ modules. 

4. Click on the Password tab. 
 

 



 

Time & Attendance Software – Setup Wizard for Payroll 3-11 

 

5. Enter a user password and confirm the password. 

Note: The minimum required password length is (6) characters with a maximum of 20 
characters. The password can be any combination of letters and numbers and is case-
sensitive. However, no spaces and/or symbols are allowed. 

Please make a note of your name (administrator/user) and password and keep in a safe 
place: 

6. Set the password expiration options. The choices are: 

 Must change password on next login: The user will be prompted to enter a new 
password for this account at login. 

 Never expires: The password created will never expire. 

 Expires after: This allows you to set a specific date for the password to expire. After this 
date the user will be prompted to enter a new password. 

 Cannot change password: The users will not be able to change their password. 

7. Click on the Pay Class tab. This tab is used to set which Pay Class the user has access to. 
The employee list will only show the employees belonging to the selected Pay Class. Use 
the Pay Class, Department and Employee tabs to filter employees by user. For example, 
certain users may only be allowed to view specific employees. 

 

 
 

By default, all Pay Classes are selected and will appear in the Selected list. Pay Classes 
can be removed from the Group by selecting them in the Selected list and clicking on the 
Remove button. All the Pay Classes can be removed from the Selected list by clicking on 
the Remove All button. 

8. Click on the Department tab. This tab is used to set the labor categories within each 
department that the user has access to. Note: If a labor level is marked red it has expired. 
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9. By default, all departments are selected and will appear in the Selected list. Departments 
can be removed from the Group by selecting them in the Selected list and clicking on the 
Remove button. All the labor categories can be removed from the Selected list by clicking 
on the Remove All button. 

Departments can be simultaneously filtered in both the “Available” and Selected” lists in 
ascending order by using the Sort field dropdown list. The choices in this list are; labor 
number, or name. 

Additionally, labor categories can be filtered in the “Available” or “Selected” lists by entering 
additional case sensitive characters in dedicated Criteria fields (see illustration). The Criteria 
field located above the “Available” list filters only that list, while the Criteria field above the 
“Selected” list filters that list. Each list is filtered independently in ascending order. 

Note: By unselecting Departments, it can reduce the Employees that the user can have access 
to. 

10. Click on the Employee tab. This tab is used to set user access to employee records. 
 

 
 

11. By default, all employee records are selected and will appear in the Selected list. Employees 
can be removed from the Group by selecting them in the Selected list and clicking on the 
Remove button. All the employees can be removed from the Selected list by clicking on the 
Remove All button. 
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Employees can be simultaneously filtered in both the “Available” and Selected” lists in 
ascending order by using the Sort field dropdown list. The choices in this list are; employee 
number, badge number, payroll number, last name, first name, or comment field. 

Additionally, Employee(s) can be filtered in the “Available” or “Selected” lists by entering 
additional case sensitive characters in dedicated Criteria fields (see above illustration). The 
Criteria field located above the “Available” list filters only that list, while the Criteria field 
above the “Selected” list filters that list. Each list is filtered independently in ascending order. 

Note: By unselecting Pay Classes, it will reduce the Employees that the user can have access 
to. 

 

Note: The Administrator cannot be deleted. 
 

12. After completing the entry/selection of information for Step 9: Login Setup, click on the 

Wizard Complete  button at the bottom of the wizard to complete the setup of Time 
Guardian and display Time Guardian login screen. The Time settings and other 
configuration data will now be populated in the software, including the time setting on the 
terminal(s). Time Guardian will poll for any connected terminals. 

Note: Employees can be entered during the initial setup process, or any time later. Employees 
can also be imported. 
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Chapter 4: Daily Use for Payroll 
 
 

File Menu 

 

 
 

The features of the File Menu are: 

 Log Off: Log off current user. 

 Synchronize Employee(s) with Payroll: Provides the ability to synchronize both the 
Amano Time & Attendance employees with QuickBooks employees. This submenu item will 
only appear after Sync Employee(s) with QuickBooks by selecting in the Setup Wizard Step 
7: Employee Setup. When the Synchronize Employee(s) with Payroll submenu is 
selected employee data are export to QuickBooks, Imported from QuickBooks, or Both 
depending on the selection on the Wizard Employee Setup. 

 Exit: Exit the application. 
 

 

Tree View 

The Tree View (see the following figure) lists the desktop module components for using 
standard Time & Attendance software without any optional modules. They are: 

Daily Activities Modules 

 Employees: Click on this module in the tree view to; Add, edit, and/or delete employees. 

 Timecard: Click on this module in the tree view to; Add and/or modify employee punches. 

 Communications: Click on this module [enabled if using Access Terminals] to remotely 
transfer functions on active terminals from the Host PC such as; poll locations, set locations 
time, download validation and settings, and view & communicate with specific 
terminals/location. 

 Recalculate: Click on this module in the tree view to recalculate employee hours for 
selected Pay periods within a given Pay Class. 

 

Output Modules 

 Reports: Click on this module in the tree view to configure, generate, and print reports 
based on employee time and attendance data. 

 Payrolls: Click on this module in the tree view to add, configure, or edit payroll company 
settings for file export. 

 Import: Click on this module to create and/or edit employee import data transfer. 
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 Export: Click on this module in the tree view to define file format and export employee data. 

 Auto Process: Click on this module in the tree view to name and set up recurrence of auto 
process for report, terminal communications, import, export, and/or synchronize Access 
Control. 

 

 
 

See the next section for a more detailed description of Tree View activity. 
 
 

 

 

Use these arrows to 
expand or collapse the 
tree view panel.
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Chapter 5: Timecard Administration for Payroll 
 

Timecard Module 

Employee punches can be viewed, added, edited, and deleted in the Timecard module. The 
Timecard module is accessed by selecting the Timecard module within the Daily Activities group 
in the Tree View. 
 

 
 

Employees can be initially filtered in ascending order by using a field with a dropdown list 
located on the top of the Timecard window (see above figure). The choices in this list are; 
Number, Badge Number, Payroll, Last Name, First Name, Middle Name, Exception, Pay 
Class, Schedule, Department Number, or Department. 

Additional filtering in ascending order can be accomplished by entering characters in a case 
sensitive field located to the right of the dropdown list (see above illustration). 

Click in the column headings anywhere to further sort both columns. Each click toggles between 
ascending and descending order. 

To view employees’ punches in the Timecard grid, click on the Timecard  button, or 
double-click on the desired employee record. To filter those employees with certain Exceptions 

click on the Exceptions list filter preferences  button, and the following window will 
appear: 
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Authorizing Payroll Export 

To authorize hours for an employee to be included in the payroll export file, place a check in the 
corresponding Hours column in the timecard on the Punches tab (see figure). This is required if 
“Hours for payroll require authorization” was checked in the Overtime Rules tab from the Pay 
Class step in the Setup Wizard. 
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Chapter 6: Output Group-Payrolls Module 
 

The Payroll Module is part of the Output Group and can be accessed by expanding the output 
group in the tree view. 
 

 

Payrolls Module 

The Payrolls module provides a way of transferring data in the system to payroll software. The 
data is usually transferred by means of a text file formatted to the payroll company’s 
specifications or directly into the payroll company database. 

Note: Activation of the Payroll Interface module can provide up to an additional 40 plus payroll 
interfaces. See Payroll Interface module section for additional information. 

 
 

Introduction 

The Amano Time & Attendance Software comes standard with a default 13 common payroll 
interfaces. The activation of the Payroll Interface Module can supply up to 43 additional payroll 
interfaces. 
 

Default Payroll Interfaces Optional Payroll Interfaces 

1. ADP DOS 

2. ADP PC Payroll for Windows 

3. CBS 

4. Excel 

5. GevityHR 

6. Paycheck Paylink 

7. Paycheck Preview 

8. Payday 

9. Peachtree 

10. Ceridian Power Pay 

11. EasyPay 

12. PayWeb 

13. QuickBooks file export/Integration 

1. ABRA 

2. ACCPAC for Windows 

3. Ahola 

4. Amano 

5. Americanhealthtech 

6. Ameripay 

7. Ceridian Encore 

8. Ceridian Esource 

9. Ceridian Insync 

10. Ceridian Source 500 

11. Ceridian Web 

12. CompuPay 

13. CYBORG 

14. DacEasy 

15. DELTEK 

16. DM Payroll 
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Default Payroll Interfaces Optional Payroll Interfaces 

17. EVOLUTION 

18. Fidelity 

19. Great Plains Dynamics 

20. HRPS/ScorPEO 

21. JD Edwards 

22. Lawson 8.1 

23. MAS 90 

24. Millenium 

25. Pay Choice 

26. PayAmerica 

27. Paycom 

28. Paycor 

29. PayMaxx 

30. PayPlus 

31. Payroll 1 

32. PayTime 

33. PeopleSoft 

34. Real World 

35. SAGE 

36. SageAccPacERP 

37. SBT VisionPoint 10 

38. Solomon 

39. Specialized Data Systems 

40. SunGuard Pentamation 

41. Timberline 

42. Ultipro 

43. Paymate Platinum 

 

Note: Due to the complexity of the Payroll Interface Profile creation, Amano recommends 
using Support to assist in defining your Payroll Interface parameters. 

 

The Payroll Interface Module provides a way of transferring data in the system to payroll 
software. The data is usually transferred by means of a text file formatted to the payroll 
company’s specifications or directly into the payroll company database. See Creating a Payroll 
Profile in the output section. 
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Creating a Payroll Profile 
 

1. Click on the Payrolls module within the Output group in the Tree View (see the following 
figure). 

 

 
 

2. To create a new Payroll Profile, click on the  button, and the following Payrolls Profile 
window will appear: 

 

 
 

3. In the Name field, enter a name for the payroll profile [required field]. This field automatically 
filled out during setup wizard with QuickBooks Pro selection. 

4. Enter a brief description of the payroll profile in the Description field. This field automatically 
filled out during setup wizard with QuickBooks Pro selection. 

5. In the Payroll field, select the type of Payroll Export file you want to create. The choices are: 
ADP DOS, ADP PC Payroll for Windows, CBS Payroll, Ceridian Power Pay, EasyPay, 
Excel, Gevity HR, PayChex Paylink, PayChex Preview, PayDay, PayWeb, PeachTree Win, 
and QuickBooks Pro. 

 
Note: The Payroll profile with name, description, payroll selection, payroll number, and output 

path will be created automatically during the initial Setup Wizard when QuickBooks Pro 
is selected to auto sync. 
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6. In the Payroll ID field, select: Payroll Number, Employee Number, Social Security Number, 
or Badge Number. 

7. In the Output Path field, enter in the directory path of the payroll file or click on the Browse 
button to set the path. An Open dialog will appear. Select the path and directory and enter in 
the filename. The filename of the payroll file is usually set by the payroll company you are 
using. 

8. Click on the Specific Payroll Settings button to see the Payroll Settings window, which are 
payroll company specific. Configure the General and Pay Codes settings tabs as per the 

desired payroll requirements and click on the  button. 
 

QuickBooks Compatibility 

Note: The Amano Time & Attendance software is compatible with the following versions of 
QuickBooks Pro for manual export: 

 QuickBooks 2010 and Enterprise 10.0 
 QuickBooks 2009 and Enterprise 9.0 
 QuickBooks 2008 and Enterprise 8.0 
 QuickBooks 2007 and Enterprise 7.0 
 QuickBooks 2006 and Enterprise 6.0 
 QuickBooks 2005 and Enterprise 5.0 (R5 and later) 
 QuickBooks 2005 and Enterprise 5.0 
 QuickBooks 2004 and Enterprise 3.0 (R7 and above) 
 QuickBooks 2003 
 QuickBooks 2002 (R2 and above) 
 QuickBooks 2002 
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See the following matrix tables for additional information on Specific Payroll Settings: 
 

QuickBooks Pro 

Examples of export iif file fields for QuickBooks Pro are shown in the following matrix table: 
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ADP For DOS 

Examples of export file fields for ADP for DOS are shown in the following matrix table: 
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ADP PC Payroll For Windows 

Examples of export file fields for ADP PC Payroll for Windows are shown in the following matrix 
table: 
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CBS Payroll 

Examples of export file fields for CBS Payroll are shown in the following matrix table: 
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Ceridian Power Pay 

Examples of export file fields for Ceridian Power Pay are shown in the following matrix table: 
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EasyPay 

Examples of export file fields for EasyPay are shown in the following matrix table: 
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Excel 

Examples of export file fields for Excel are shown in the following matrix table: 
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Gevity HR 

Examples of export file fields for Gevity HR are shown in the following matrix table: 
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Paychex Paylink 

Examples of export file fields for Paychex Paylink are shown in the following matrix table: 
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Paychex Preview 

Examples of export file fields for Paychex Preview are shown in the following matrix table: 
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PayDay 

Examples of export file fields for PayDay are shown in the following matrix table: 
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PayWeb 

Examples of export file fields for PayWeb are shown in the following matrix table: 
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Peachtree Win 

Examples of export file fields for Peachtree Win are shown in the following matrix table: 
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9. Click on the Date Range tab. The following is an example of the Date Range tab window: 
 

 
 

10. In the Date Selection field, select the date range for the report. The choices are; Today, 
Yesterday, Last Open Period, Previous Open Period, Current Week, Previous Week, 
Current Month, Previous Month, Last 2 Weeks, Date Range, Current Pay period, and 
Previous Pay period. 

Note: When Current Pay period and Previous Pay period are selected, the first Pay Class in 
the Selected List on the Pay Class tab will be used as the date range for the file. 

11. If Date Range was chosen as the Date Selection, you must enter the From Date and Until 
Date using the Calendar icon. You also have the option of going forward or backward as 
many days, weeks, months, or years from the From Date using the Forward and Backward 
options. 

12. Click on the Breaks tab. The Breaks tab determines which departments in the Amano Time 
& Attendance software that will be passed to the Payroll Export file. The number of 
departments to be passed on is dependent upon the payroll company you are using. The “- - 
- - - - - - - - - -“ selection will leave that particular department field blank in the payroll file. 
The following is an example of the Breaks tab window: 

 

 

 

 To add a department to the payroll file, highlight the desired Labor Level in the Available 
list and click on the Add button. 

 To add all departments to the payroll file, click on the Add All button. 
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 The departments in the payroll file will be separated in the order that they appear in the 
Selected list. To change the order of the departments in the Selected list, select the 
desired department, and click on the Move Up and Move Down button. 

 To remove a department from the payroll file, highlight the desired department in the 
Selected list and click on the Remove button. To remove all selected departments, click 
on the Remove All button. 

13. Click on the Pay Class tab. The following is an example of the Pay Class tab window: 
 

 
 

 To add a Pay Class to the payroll file, highlight the desired Pay Class in the Available list 
and click on the Add button. 

 To add all Pay Classes to the report, click on the Add All button. 

 To remove a Pay Class from the payroll file, highlight the desired Pay Class in the 
Selected list and click on the Remove button. 

 To remove all selected Pay Classes, click on the Remove All button. 

14. Click on the Department tab. The following is an example of a Department tab window: 
 

 
 

15. To add a department category to the payroll file, highlight the desired department category 
in the Available list and click on the Add button. To select all departments for the payroll file, 
click on the Add All button. To remove a department from the payroll file, highlight the 
desired category in the Selected list and click on the Remove button. To remove all selected 
departments, click on the Remove All button. 

 To add a Labor Level category to the payroll file, highlight the desired Labor Level 
category in the Available list and click on the Add button. 
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 To add all categories of the Labor Level to the report, click on the Add All button. 

 To remove a category of the Labor Level from the payroll file, highlight the desired 
category in the Selected list and click on the Remove button. 

 To remove all selected categories of the Labor Level, click on the Remove All button. 

 Filter departments shown in the “Available” and “Selected” lists by selecting a sort item 
in the dropdown list in the Sort field. Then enter data in the Criteria field(s) above either 
or both lists. Only categories of the department matching the data entered will appear in 
both lists. 

16. Click on the Employee tab. The following is an example of a Employee tab window: 

 

 

 

 To add an employee to the payroll file, highlight the desired employee in the Available 
list and click on the Add button. 

 To add all employees to the report, click on the Add All button. 

 To remove an employee from the payroll file, highlight the desired employee in the 
Selected list and click on the Remove button. 

 To remove all selected employees, click on the Remove All button. 

 Filter employees shown in the “Available” and “Selected” lists by selecting a sort 
category in the dropdown list in the Sort field. Then enter data in the Criteria field(s) 
above either or both lists. Only employees matching the data entered will appear in both 
lists. 

 

 

Generating the Payroll File 

To generate a payroll file from the Payroll Profile, select the desired Payroll Profile from the list 

in the Table View, and click on the Run Payroll  button and the following message will 
appear: 
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Note:  An error message may appear if the Payroll interface cannot be created. Please check 
the Payroll Settings and/or consult Amano support if necessary. 

 

 

QuickBooks Manual Integration 

 

Follow these procedures for QuickBooks Direct or File Integration: 
 

Section 1: Direct QuickBooks Integration [Export, Import or Both] 

 

Part A - Configuration 

Step 1. During installation of the Amano Time & Attendance software the Setup Wizard in 
Step 1: General Setup will ask; Do you want to send employee hours to your 
payroll software? Select Yes. 

Step 2. Select Direct integration from the dropdown menu for How do you want to export 
QuickBooks? 

Step 3. Select Yes for Is QuickBooks installed on the current PC? It is recommended to 
have QuickBooks installed on the current PC and open for successful direct 
integration. 
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Part B – Employee Exchange 

Step 1. From Setup Wizard in Step7: Employee Setup, check the box to Sync Employee(s) 
with QuickBooks and select the method of synchronization from the dropdown 
choices of; Import from QuickBooks, Export to QuickBooks, or Both ways [bi-
directional]. 

 

 
 

Step 2. The selection of Direct Integration for QuickBooks will auto create the QuickBooks Pro 
payroll template. From the tree view select the Payrolls module and double-click on the 
created QuickBooks Pro payroll template to define the Name, Description, Payroll, 
and/or Payroll ID fields or just use the default entries. 

 

 
 
 
 
 
 
 
 
 
 

Step 3. From the File menu in the Time & Attendance software, select “Synchronize 
Employee(s) with Payroll”. The “Please make sure that QuickBooks is running 
before proceeding to synchronize” message will appear  click OK to proceed. The 
“Synchronizing Payrolls” message will appear followed by the message 
“Successfully synchronized employees with QuickBooks”  click OK to finish. 
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Part C – Payroll Export 

Step 1. Click on the Specific Payroll Settings button to perform Pay Code mapping. 
QuickBooks should be configured for your company. From the General tab select if 
you want to Overwrite duplicate payroll entries for Direct Integration. If this box is 
not checked, the hours sent will be duplicated each time hours are transferred to 
QuickBooks. 

 

 
 

Step 2. Click on the Paycodes tab to perform Paycodes mapping with QuickBooks from the 
QuickBooks Pay Code(s) screen. Select the “Mapping” browse button alongside the 
Time & Attendance Pay Code listed on the left side to map the QuickBooks Pay Code. 
The QuickBooks Pay Code will appear in the “Value” column. 

 

 
 

 

Note – Failure to perform and/or correctly map Pay Codes could result in non-
synchronization. The “Item Name” in QuickBooks = Pay Code in the Time & 
Attendance software. 

 

Step 3. From the Time & Attendance software Payrolls screen, click on the Employee tab (see 
figure), and select the employees from the Available List to be included in the payroll 
file. 
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 To add an employee to the payroll file, highlight the desired employee in the 
Available list and click on the Add button. 

 To add all employees to the report, click on the Add All button. 

 To remove an employee from the payroll file, highlight the desired employee in the 
Selected list and click on the Remove button. 

 To remove all selected employees, click on the Remove All button. 

 Filter employees shown in the “Available” and “Selected” lists by selecting a sort 
category in the dropdown list in the Sort field. Then enter data in the Criteria field(s) 
above either or both lists. Only employees matching the data entered will appear in 
both lists. 

Step 4. Save the Payroll Settings you just created and then select the Run Payroll  icon to 
generate the payroll export file from the Time & Attendance software. 

Step 5. From the File menu in the Time & Attendance software, select “Synchronize Employee(s) 
with Payroll”. The “Please make sure that QuickBooks is running before proceeding to 
synchronize” message will appear  click OK to proceed. The “Synchronizing Payrolls” 
message will appear followed by the message “Successfully synchronized employees with 
QuickBooks”  click OK to finish. 

The synchronization will be performed depending on what was selected for the method of 
synchronization in the Wizard Employee Setup for how to Sync Employee(s) with 
QuickBooks with the choices of; 

 Import from QuickBooks – QuickBooks acts as the master. Suggested for scenario 
where you already have the QuickBooks as the payroll software and the Time & 
Attendance software is being added. 

 Export to QuickBooks - Suggested for scenario where you already have the Time & 
Attendance software and QuickBooks is being added as the payroll software. 

 Both ways – Employee information will bi-directional transfer, but QuickBooks remains 
as the master. If employee is changed in the Time & Attendance software, the employee 
change must be updated in QuickBooks to maintain good synchronization. 

The Time & Attendance software can accept the QuickBooks payperiod settings of; Weekly, Bi-
Weekly, Semi-Monthly, and Monthly. Any different payperiod setting in QuickBooks will 
automatically be defined as Weekly when transferred to the Time & Attendance software. 
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Note – QuickBooks Payroll integration can also be setup by selecting the Setup Wizard 
from the File Menu in the Time & Attendance software. Click on General & Employee 
tabs to configure. Select Payrolls module from the tree view and create the QuickBooks 
payroll profile. 

 

 

Note – For auto synchronization to work: QuickBooks Pro version 7 or higher must be 
installed and QuickBooks Pro must be started up first and running before starting up 
the Amano Time & Attendance software. 

 

 

Section 2: iif File QuickBooks Integration [Export] 

Part A - Configuration 

Step 1. During installation of the Amano Time & Attendance software the Setup Wizard in 
Step 1: General Setup will ask; Do you want to send employee hours to your 
payroll software? Select Yes. 

Step 2. Select *.iif file from the dropdown menu for How do you want to export 
QuickBooks? 

 

 
 

 

Part B – Employee Exchange 

Step 1. From the main menu of QuickBooks select File (see figure). 
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Step 2. Select Utilities  Export  Timer Lists and the following screen will appear: 
 

 
 

Step 3. Enter the name for the payroll file in the File name field (see figure). It is recommended 
to use an .iif file extension. 
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Step 4. Click Save button and if successful a message will appear; “Your data has been exported 
successfully”. After the file has been saved, open the file using Notepad (see figure). 
Information from this file will be used to create the export file from the Amano Time & 
Attendance software. 

 

 
 

Part C – Payroll Export 
 

Step 1. From the tree view in the Time & Attendance software select the Payrolls module and 
double-click on the created QuickBooks Pro payroll profile to define the Name, 
Description, Payroll, and/or Payroll ID fields or just use the default QuickBooks entries. 
If necessary browse to define the Output Path for the iif file. 

 

 
 
 
 
 
 
 

Step 2. In the Payroll ID field, select: Payroll Number, Employee Number, Social Security 
Number, or Badge Number. 

Step 3. In the Output Path field, enter in the directory path of the payroll file or click on the 
Browse button to set the path. An Open dialog will appear. Select the path and 
directory and enter in the filename. The filename of the payroll file is usually set by the 
payroll company you are using. 

Step 4. Click on the Specific Payroll Settings button to see the Payroll Settings window, 
which are payroll company specific. The following are examples for QuickBooks Pro 
Payroll Settings General and Pay Codes tab screens. Configure the General and Pay 

Codes settings tabs as per the QuickBooks Pro requirements and click on the  
button. 
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Step 5. Enter the version number of the QuickBooks package you are using. This information 
can be obtained from QuickBooks iif file opened with Notepad (see figure). 

Step 6. Enter the release number of the QuickBooks package you are using. This information 
can be obtained from QuickBooks iif file opened with Notepad in (see figure). 

Step 7. Enter the Company Name from QuickBooks. This information can be obtained from 
QuickBooks iif file opened with Notepad (see figure). 

Step 8. Enter the Create Time number from the QuickBooks package you are using. This 
information can be obtained from QuickBooks iif file opened with Notepad (see figure). 
The Time & Attendance software will enter a default value in the Export To field. 
Choose the location and file name for the export file. This information is entered in the 
select path field. 

Step 9. Once all the fields for the General Payroll Settings have been entered, click on the Pay 
Codes tab (see figure) and select the Pay Codes that you want transferred from the 
Time & Attendance software to QuickBooks. Assigning a payroll ID to the desired pay 
codes will do this. A complete list of payroll Ids can be found in QuickBooks payroll 
items. The “Item Name” in QuickBooks = Pay Code in the Time & Attendance 
software. 

 

 
 

Example of Amano Time & Attendance Pay Codes vs. QuickBooks Payroll Field IDs: 
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Time Guardian Pay Codes QuickBooks Payroll Field ID 

REG Regular Pay 

HOL Holiday Pay 
 

 

Step 10. From the Time & Attendance software Payrolls screen, click on the Employee tab (see 
figure), and select the employees from the Available List to be included in the payroll 
file. 

 

 
 

 To add an employee to the payroll file, highlight the desired employee in the 
Available list and click on the Add button. 

 To add all employees to the report, click on the Add All button. 

 To remove an employee from the payroll file, highlight the desired employee in the 
Selected list and click on the Remove button. 

 To remove all selected employees, click on the Remove All button. 

 Filter employees shown in the “Available” and “Selected” lists by selecting a sort 
category in the dropdown list in the Sort field. Then enter data in the Criteria field(s) 
above either or both lists. Only employees matching the data entered will appear in 
both lists. 

Step 11. Save the Payroll Settings you just created and then select the Run Payroll  icon 
to generate the payroll export file from the Time & Attendance software. 

Step 12. Once the export file has been created from the Amano Time & Attendance software it 
can now be imported by QuickBooks. From QuickBooks select File from the main 
menu (see figure). 
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Step 13. From QuickBooks Pro, select Utilities =>Import => Timer Activities and the following 
QuickBooks screen will appear: 

 

 
 

Step 14. Select OK to continue and select the file to be imported (see figure). This is the file 
name that was defined in Time Guardian. Highlight the file as illustrated in the example 
figure and select open. 

 

 
 

Step 15. From QuickBooks view the imported employee information, create paychecks if 
desired, and/or submit for payroll. 
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QuickBooks Auto Integration 

Note: For auto synchronization to work: QuickBooks Pro version 7 or higher must be installed. 
Also, QuickBooks Pro must be started up first and running before starting up the Amano 
Time & Attendance software. 

The following procedure describes how to setup the Amano Time & Attendance software for 
QuickBooks Pro auto integration/synchronization. 
 
 

Part A - Configuration 

Step 1. During installation of the Amano Time & Attendance software the Setup Wizard in 
Step 1: General Setup will ask; Do you want to send employee hours to your 
payroll software? Select Yes. 

Step 2. Select Direct integration from the dropdown menu for How do you want to export 
QuickBooks? 

Step 3. Select Yes for Is QuickBooks installed on the current PC? It is recommended to 
have QuickBooks installed on the current PC and open for successful direct 
integration. Note – You can select No and integrate with QuickBooks on a server 
[remotely] but the QuickBooks still has to be open for successful integration 
[synchronization]. 

 

 
 

 

Part B – Employee Exchange 

Step 1. From Setup Wizard in Step7: Employee Setup, check the box to Sync Employee(s) 
with QuickBooks and select the method of synchronization from the dropdown 
choices of; Import from QuickBooks, Export to QuickBooks, or Both ways [bi-
directional]. 
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Step 2. The selection of Direct Integration for QuickBooks will auto create the QuickBooks Pro 
payroll template. From the tree view select the Payrolls module and double-click on the 
created QuickBooks Pro payroll template to define the Name, Description, Payroll, 
and/or Payroll ID fields or just use the default entries. 

 

 
 
 
 
 
 
 
 
 
 

Step 3. From the File menu in the Time & Attendance software, select “Synchronize 
Employee(s) with Payroll”. The “Please make sure that QuickBooks is running 
before proceeding to synchronize” message will appear  click OK to proceed. The 
“Synchronizing Payrolls” message will appear followed by the message 
“Successfully synchronized employees with QuickBooks”  click OK to finish. 

 

 

Part C – Payroll Export 

Step 1. Click on the Specific Payroll Settings button to perform Pay Code mapping. 
QuickBooks should be configured for your company. From the General tab select if 
you want to Overwrite duplicate payroll entries for Direct Integration. If this box is 
not checked, the hours sent will be duplicated each time hours are transferred to 
QuickBooks. 
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Step 6. Click on the Pay codes tab to perform Pay codes mapping with QuickBooks from the 

QuickBooks Pay Code(s) screen. Select the “Mapping” browse button alongside the 
Time & Attendance Pay Code listed on the left side to map the QuickBooks Pay Code. 
The QuickBooks Pay Code will appear in the “Value” column. 

 

 
 

 

Note – Failure to perform and/or correctly map Pay Codes could result in non-
synchronization. The “Item Name” in QuickBooks = Pay Code in the Time & 
Attendance software. 

 
Step 7. From the Time & Attendance software Payrolls screen, click on the Employee tab (see 

figure), and select the employees from the Available List to be included in the payroll 
file. 
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 To add an employee to the payroll file, highlight the desired employee in the 
Available list and click on the Add button. 

 To add all employees to the report, click on the Add All button. 

 To remove an employee from the payroll file, highlight the desired employee in the 
Selected list and click on the Remove button. 

 To remove all selected employees, click on the Remove All button. 

 Filter employees shown in the “Available” and “Selected” lists by selecting a sort 
category in the dropdown list in the Sort field. Then enter data in the Criteria field(s) 
above either or both lists. Only employees matching the data entered will appear in 
both lists. 

Step 8. Save the Payroll Settings you just created and then select the Run Payroll  icon 
to generate the payroll export file from the Time & Attendance software. 

Step 9. From the File menu in the Time & Attendance software, select “Synchronize 
Employee(s) with Payroll”. The “Please make sure that QuickBooks is running 
before proceeding to synchronize” message will appear  click OK to proceed. The 
“Synchronizing Payrolls” message will appear followed by the message 
“Successfully synchronized employees with QuickBooks”  click OK to finish. 

The synchronization will be performed depending on what was selected for the method of 
synchronization in the Wizard Employee Setup for how to Sync Employee(s) with 
QuickBooks with the choices of; 

 Import from QuickBooks – QuickBooks acts as the master. Suggested for scenario 
where you already have the QuickBooks as the payroll software and the Time & 
Attendance software is being added. 

 Export to QuickBooks - Suggested for scenario where you already have the Time & 
Attendance software and QuickBooks is being added as the payroll software. 

 Both ways – Employee information will bi-directional transfer, but QuickBooks remains 
as the master. If employee is changed in the Time & Attendance software, the employee 
change must be updated in QuickBooks to maintain good synchronization. 

The Time & Attendance software can accept the QuickBooks payperiod settings of; Weekly, Bi-
Weekly, Semi-Monthly, and Monthly. Any different payperiod setting in QuickBooks will 
automatically be defined as Weekly when transferred to the Time & Attendance software. 
 

 

Note – QuickBooks Payroll integration can also be setup by selecting the Setup Wizard 
from the File Menu in the Time & Attendance software. Click on General & Employee 
tabs to configure. Select Payrolls module from the tree view and create the QuickBooks 
payroll profile. 
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Chapter 7: Web Interface Module for Payroll 

 

Web Interface Module Introduction 

Time Guardian Pro comes standard with the Web Interface module, while Time Guardian and 
Time Guardian Plus require it to be activated as an optional module. 

The description of this module will utilize Time Guardian Pro screens for illustrative purposes. 

The activation of the Web Interface Module provides a punch web view that allows the 
employee to punch IN or OUT. This operates with same functionality as the Amano MTX-15 
and/or FPT-40 clock provides. The employee may be capable of doing labor transfers from the 
punch submission screen. Also, the employee will be able to denote whether the punch is for a 
coffee break, break, or meal. 

However, the Web Interface Module will provide two (2) distinct parts/capabilities; 1 part will be 
for employee access, and the 2nd part will be for supervisor only access. 

The sections of the Time & Attendance Software affected and/or features added from the 
activation of this module include: 

 Employee Configuration (Web Access) 

 Employee Global Assign (Web Access) 

 Employee Portal 

 Web Punch In 

 View Previous Punches 

 View Time Sheet 

 Make Adjustments 

 Reset Password 

 Run Schedule Posting Report 

 Supervisor Portal 

 Access list of supervise Employees 

 Add/Edit/Delete Employees if granted 

 View/Edit Employees Time Card if granted 

 Run Reports 
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Authorizing Payroll Export 

To authorize hours for an employee to be included in the payroll export file, place a check in the 
corresponding Hours Auth column (see the figure). 
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